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1 : Introduction

Please install on your PC the drivers for SC devices first. 
These drivers are on the CDROM given in any SC100 or SC200 kits.
Installing these drivers is necessary for your NAUTEEK device to work correctly with the 
PC softwares. For more information about how to install the NAUTEEK drivers, please 
refer to the user manuals.
The NAUTEEK Waypoint Manager V1.0 is only supported on the following OS :  Windows 
XP et Vista.

2 : How to install the NAUTEEK WaypointManager firmware?

Download the new NAUTEEK WaypointManager software from our website : 
www.nauteek.com

Unzip this file and launch the install file named Setup.exe.
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Chose your language and click  OK.

Click on Next.

Select the destination folder and click on Next.
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Click on Next.

To create a desktop icon, click on Next.
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If you do not want desktop icon, just do not check off 'create an icon on your desktop' and 
click on Next. 

Click on Install.
Please wait a small while : install is in progress.
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Click on Finish.

We advise to restart your computer before to start the NAUTEEK WaypointManager.

Congratulations, your new software is now ready to be used.

3 : Starting the NAUTEEK WaypointManager

To start the NAUTEEK WaypointManager you can  :

– either double-click on your desktop icon.

– Or launch the Program from the START Menu.

As default factory setting, the NAUTEEK WaypointManager starts in French on a new 
empty data base file.
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3.1 : NAUTEEK WaypointManager menu overview:
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Chose the default display format 
of the coordinates of your 
waypoints.

Chose the language of your 
NAUTEEK WaypointManager 
software in Options

In the Edition menu, you will be 
able to create waypoints, create 
routes, delete waypoints and 
delete routes.

In the File menu, you will find the 
different choices:
-create a new database file of  
Waypoints and Routes
-open a saved database file.
-save a new database file.
-add a saved file to the active 
open file to modify it ( merge 
function)
Open the COM port to your SC 
and realize import / export of files 
via USB in File also.



3.2 : Waypoints and routes files.

The waypoints and routes data base files for your NAUTEEK devices are saved as .nk 
files.
They are saved in the Data folder under the Nauteek WaypointManager directory on your 
C drive as default factory setting.
You will also be able to save them on any folder of your choice.

4 : Waypoints

4.1 : Coordinates format of waypoints

The NAUTEEK WaypointManager interface allows you to enter the coordinates of your 
waypoint according to the different following formats.
Please note that automatic format conversion can be done by the NAUTEEK 
WaypointManager interface.
Chose the default display format of the coordinates of your waypoints in the Options menu.
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Format # 1 : 

Info sign degrees minutes sign

Latitude +/- Decade Units ° Decade Units . Tenth Hundredth Thousandth N/S

Longitude +/- Hundred Decade Units ° Decade Units . Tenth Hundredth Thousandth E/W

Example : 

or 

Remark 1: keep in mind to use ' . ' and  not ' , ' before the tenth.
Remark 2: if you add the 'W' info  to a negative longitude, the longitude will 
automatically be converted as an East longitude : E signed.

Format   #   2:  

Info sign degrees minutes seconds sign

Latitude +/- Decade Units ° Decade Units ' Decade Units '' N/S

Longitude +/- Hundred Decade Units ° Decade Units ' Decade Units '' E/W

Example : 

or
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Format # 3 : 

Info sign degrees sign

Latitude +/- Decade Units . tenth hundredth thousandth N/S

Longitude +/- Hundred Decade Units . tenth hundredth thousandth E/W

Example :

or

Remark : keep in mind to use ' . ' and  not ' , ' before the tenth

The NAUTEEK WaypointManager knows how to to convert automatically the coordinates 
according the format you chose in the Option menu.
However the format of the coordinates displayed for waypoints on your SC screen will be 
fixed as : 

Info degrees minutes sign

Latitude Decade Units ° Decade Units . tenth hundredth thousandth N/S

Longitude Hundred Decade Units ° Decade Units . tenth hundredth thousandth E/W

4.2 : Creating a new waypoint

Click on to create a new waypoint or use the ' CTRL+W' short cut:
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 Remark : use up to 8 characters to name your new waypoint.

Click   to validate this new Waypoint entry.

4.3 : Editing and modifying a waypoint

You can edit and modify a waypoint at any time. To modify a waypoint, select the waypoint 
into the waypoint list and use the edition fields on the bottom left of the screen :

4.4 : Deleting a waypoint

Select the waypoint in the waypoint list and click :  
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Click YES to validate your choice.

 

4.5 : Creating a waypoints list

Use the list given on the Notice of Race (NoR) and fill in your file to add as many 

NAUTEEK is a brand of IMARTEC SARL www.nauteek.com



waypoints as needed

5 : Creating a route 

5.1 : Creating a new route 

Click to create a new route or use the following short cut :CTRL +R

You can use up to 8 characters to name the new route:
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At any time, feel free to rename the route by editing its name(two left click)

5.2 : Adding a waypoint to a route

To add a waypoint to a route :

1/ Select a route among the route list.

2/ Select a waypoint to insert to the route and :

– press the space key of your keypad to insert the waypoint
or

– double click on the waypoint in the waypoint list
or

– click once the correct waypoint selected.
or

– do a 'drag & drop' up to the route.
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5.3 : Modifying the starboard (S) / port board (P)  waypoint 

Double click on the waypoint to change the starboard / port board status of a waypoint.
This status loops from P to S and the color of the waypoint name changes from red to 
green. 

By default, the status of a new inserted waypoint will be Starboard

The P/S  status of the active waypoint will be regularly (once per minute on V2.0 firmware 
version) displayed on your SC when a route will be running.

5.4 : Modifying the waypoint order in a route.

Select the waypoint you want to move into the list and do a 'drag & drop' to move the 
waypoint to the needed place.
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Remark : a route cannot contain more than 50 waypoints

5.5 : Removing a waypoint from a route

Select the waypoint you want to remove from the selected route and : 

- click : 

or

- press the 'DEL' key of your keypad.

Click YES to validate your choice.
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Remark : the waypoint is only removed from the route and not from the waypoint list, 
where it is still available.
 

5.6 : Deleting a route

Select the route to delete into the route list and click : 

or 

press the 'DEL' key of your PC keypad:

Click YES to validate your choice.

6 : Exporting waypoints and routes files from your PC to your SC 
device.

Once routes and waypoints are created via the NAUTEEK WaypointManager PC interface, 
the software will allow you to load your new .nk file to your SC.

Remark : you can load up to 750 waypoints in your SC device and up to 150 routes (of 10 
waypoints each).

Once routes and waypoints are created via the NAUTEEK WaypointManager PC 
interface, remember to save your file on your PC:
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6.1 : Connecting your SC via USB

1/ Switch your SC device on and plug the USB cable to link the device to your PC. Wait a 
until your SC is detected. 
Reminder : remember to save your active file before any connection or any data 
transfer to your SC device.

2/ Go to File / NAUTEEK DataBase / connection

Once your SC device has been detected, the following message will be displayed on the 
bottom left of your software window:

The Export / import features are ready to be used.
, 

6.2 : Exporting the data to the SC device
Reminder : remember to save your active file before any connection or any data 
transfer to your SC device.
Once connected, you can load your data to your SC. Click on :
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The following message is automatically displayed on your screen.

If you want to replace the waypoints & routes data content of your SC by the new active 
file, click : YES.

The data transfer is now in progress, please wait a small while.
The following message is displayed until the transfer is in progress: 

 
Look at the SC device screen, it gives you real time information about the percentage of 
transferred data.
Once the transfer is finished, the progress bar on the SC screen has disappeared.
The new message is now displayed on your PC screen:

Congratulations, you have correctly exported new data in your SC.

You can now consult, edit, modify the exported routes and waypoints directly from your SC 
device. You can also add new routes, new waypoints and so on directly from the SC.
Remember that you can export as many times as you want new files to your SC, so 
remember to use the user friendly interface of the NAUTEEK WaypointManager to make 
your changes.

7 : Importing waypoints and routes from the SC to your PC

If you have, directly from your SC device:
-added new routes
-modified routes
-added waypoints
-modified waypoints.
The Import feature will allow you to save the modified content of your SC device into a new 
database file on your PC.
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7.1 : Connecting your SC via USB

1/ Switch on your SC device and plug the USB cable to link the device to your PC. Wait a 
small while for your SC to be detected. 
Reminder : remember to save your active file before any connection or any data 
transfer to your SC device.
2/ Go to FIle / NAUTEEK DataBase / connection

Once the COM port connection established, the following message will be displayed on 
the bottom left of your software window:

The Import feature is ready to be used.

7.2 : Importing the SC data to the PC

Reminder : remember to save your active file before any connection or any data 
transfer to your SC device.

To import the data stored on your SC to your PC, click : 
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If your PC interface is empty, just click : NO.
Or click YES and save your current data base file as a . nk file.

The data transfer is now in progress, please wait a small while.
The following message is displayed until the transfer is in progress: 

 
Look at the SC device screen, it gives you real time information about the percentage of 
transfered data.
Once the transfer is finished, the progress bar on the SC screen will disappear.
The new message is now displayed on your PC screen:

The data stored on your SC is now available on your screen. You can modify it, rename 
the routes, and so on.

Reminder : remember to save your active file after importing data from the SC.

Congratulations, you have correctly imported the data stored in your SC.

8 : Creating .nk files according to your sailing areas. Splitting your 
waypoints database.

8.1: Managing your data

In order to improve the useability of your device on the water when racing, remember to 
manage your waypoints and routes data into different .nk files according to the different 
sailing areas where you often go sailing.
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If you worked with different files according to different sailing areas, you will be able to 
bring with you only the correct nk file corresponding to your next race and not all of your 
waypoints.
Therefore, when racing, you will save time in your waypoints or your routes lists, and you 
will increase the readability and the ease of use of your SC.
It will be faster to make a GOTO among a list of 20 waypoints rather than 100 waypoints!

8.2 : Merging 2 or more data base files. 

If you worked with different files according to different sailing areas, you will be able to 
exchange files with friends and to merge theme. It will help you to save time also!
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When merging files, the NAUTEEK waypointManager software will advise you about 
importing waypoints called with the same name and will propose you the different choices : 

 

9 : Opening a .nk file

Open a stored data base .nk file it to edit it and / or modify it.
Click Open in the File menu.
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Save the changes of the current active file if necessary.

Chose the .nk data base file you want to open and click Open.  
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10 : Direct saving
You can directly save the content of your SC device by creating a .nk file on your PC 
without displaying its content on thePC screen.

Once your SC device connected via USB, click on Direct Saving.

Give a name to this new .nk file you want to directly save and click on SAVE to start the 
direct import.

The direct saving is in progress:  
Please wait a small while.
The following message is displayed until the transfer is in progress: 

 
Look at the SC device screen, it gives you real time information about the percentage of 
transfered data.
Once the transfer finished, the progress bar on the SC screen has disappeared.
The new message is now displayed on your PC screen:

The data stored on your SC is now available in the new file, saved in the Data folder. 
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11 : Deleting all the stored routes and waypoints on your SC 

The SC device user interface does not allow you to delete neither waypoints, nor routes.
From the SC user interface, you can only remove waypoints from stored routes.
To delete all the stored routes and waypoints on your SC, just export an empty file from 
your PC to the SC.
All stored data in your SC device will also be replaced.
Your SC device will be empty of routes and waypoints.
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